
Below is a list of categorized Frequently Asked Questions regarding the Symantec System 

Recovery (SSR) 2013 R2 release. 

For general SSR 2013 R2 documentation, release notes, software compatibility lists visit: 

(TECH225253) - Symantec System Recovery 2013 R2 General Information 

  

SYSTEM RECOVERY DISK (SRD) 

  

NOTE: Refer to (TECH225888) - How to create a Symantec System Recovery 2013 R2 (SSR 

2013R2) System Restore Disk (SRD) for information on changes in how to create a SRD for 

SSR 2013 R2 release. 

 

  

   SRD Availability 

·       Is WinPE still in use?  

·       Will SRD be available on FileConnect?  

·       Will the SRD CD be shipped with SSR 2013 R2?  

   

   SRD Creation utility 

·       What are the highlights for SRD with SSR 2013 R2?  

·       Where is the new SRD Creation utility located in the installer?  

·       Is the SRD Creation utility installed by default with the package?  

·       Does the SRD Creation utility support the existing functionality?  

·       Can both 32-bit and 64-bit SRDs be created?  

·       What firmware can 64-bit SRD be booted on?  

   

   SRD Requirements 

·       State the operating systems on which SRD can be created?  

·       What are the requirements for SRD creation?  

·       Where can SRDs be created?  

·       How much space does the SRD Creation utility require?  

·       Which features need to be selected while installing Microsoft ADK?  

   

   SRD Menu 

·       What are the new menu options available with SSR 2013 R2?  

·       Are these options also available when connected to a remote client?  

   

   SRD Prompts and Status messages 

·       Is there a menu option available to check the SRD creation status?  

·       When SSR 2013 R2 is launched, is there a prompt with information about the SRD 

creation status?  

·       Is there a prompt to create an SRD after product installation?  

http://www.symantec.com/docs/TECH225253
http://www.symantec.com/docs/TECH225888


·       Is there a prompt to create an SRD after product installation on an unsupported 

operating system?  

   

   SRD Typical and Advance creation methods 

·       What are the two different methods to create an SRD?  

·       List the key parameters that need to be considered before choosing between the 

Typical and Advanced option?  

·       What type of installation recommended on the latest operating systems supported by 

SSR 2013 R2?  

·       What is the SRD creation based on when the Typical SRD creation option is used?  

·       What is the SRD creation based on when the Advanced SRD creation option is used?  

·       What does the user need to download and install during SRD creation (Advanced)?  

·       What features are available when the Typical option is used for Windows 8.1 update 

1/ Windows Server 2012 R2 as host operating system?  

·       What happens when SSR users do not have Windows 8.1 update or Windows Server 

2012 R2 update and still want to use the Typical option?  

·       What is the Recoverability Matrix for the Typical option?  

·       What is the Recoverability Matrix for the Advanced option?  

·       Which method of SRD creation is faster?  

·       Why does the Typical option take lesser time?  

·       Why does the Advanced option take longer?  

·       Are progress bars and time updates available for the Advanced option?  

·       What are the temporary/staging area considerations?  

·       What are the Advanced language options for SRD creation?  

·       What are the SRD Target Media limitations?  

·       What are the new options added to the driver mining page of the Customize SRD 

wizard?  

·       Is there any information about the driver mined displayed in the GUI?  

·       How is the locally mined driver list displayed when a 32-bit SRD is created on a 64-

bit machine?  

·       Can a higher version driver be added to a lower version SRD?  

·       Why are drivers that are not compatible with WinPE added to the Driver database?  

·       When is the Typical option not available?  

   

   SRD Customization 

·       Name the features in SRD customization that are unchanged?  

·       What customization features are available during SRD creation?  

·       What is the use of the SRD Customization feature?  

·       Does SSR 2013 R2 provide the SRD customization feature for all operating systems?  

·       What are the limitations of base SRD during customization?  

·       On which operating systems is SRD customization possible?  

  

   SRD Recovery Environment 

·       Does SSR 2013 R2 support pcAnywhere?  

·       Does Help in the SRD environment contain Hyperlinks?  

·       Is the WebControl component available for SRD?  



·       When is an error message generated?  

   

   SRD telemetry 

·       What information is captured to understand customer preferences?  

·       When is the telemetry message displayed?  

   

   SRD WIM utility 

·       Which new utility is added to clean up mounted wims in case they are left un-

mounted?  

·       What is the command to execute Wimcleaner.exe?  

   

   

   SRD Troubleshooting/logs 

·       Where are the SRD creation and customization logs located?  

·       Name the log files related to SRD creation and customization?  

·       Where are the log files for Wimcleaner.exe located?  

   

LICENSING 

  

·       Has the licensing methodology changed from the previous versions of SSR?  

·       Can SSR users upgrade to SSR 2013 R2 free of cost?  

·       Will SSR 2013 R2 be available on FileConnect?  

·       Will SSR 2013 R2 be available via LiveUpdate?  

·       Does basic SRD creation require any licenses?  

 

   

LIGHTSOUT RESTORE (LOR) PACKAGING 

  

·       Can LOR be setup on a local system?  

·       When can LightsOut Restore (LOR) be created?  

·       If LOR is already setup on the machine, will it be available in the menu options?  

·       Can I install only the LOR option?  

·       What does LOR use on WinRE based operating systems (Windows 7 onwards)?  

·       Will the LOR package (SSR-MS) be available on the Global Product list?  

·       Will the SRD creation utility package be available as a part of SSR-MS 2013 R2 

installation?  

·       Will the LOR package be distributed with SSR-MS 2013 R2?  

·       Do I need to create the LOR Package using the SRD Creation utility?  

·       What is the new entry in the Getting Started Webpart for LOR?  

·       List the steps displayed in the Creating the Symantec Recovery Disk (ISO) and 

generating LightsOut Restore link?  

·       Where is a copy of the SRD (ISOs) available?  

·       State the option in the GUI to generate the LOR Package?  



·       How do I upload 32-bit and 64-bitRecovery Disk (ISOs) when Generating LightsOut 

Restore Package?  

·       Is there a new page available in the Package and Policies tab for LOR?  

  

SYMANTEC MANAGEMENT PLATFORM (SMP) 7.5 PLATFORM SUPPORT 

  

·       What is the SMP (Symantec Management Platform) 7.5 supportability matrix in SSR 

2013 R2?  

·       Will SSR-MS 2013 R2 be listed in SIM?  

·       Which SMP version has reached End of Life with SSR 2013 R2?  

·       Is the SSRMS_x 32 build available with SSR 2013 R2?  

·       Which older versions can be upgraded to SSR-MS 2013 R2?  

·       Can a user running SSR-MS 2013 R2 manage a client running BESR 2010?  

·       Where are the SMP Server logs located?  

·       Where are the SMP Agent logs located?  

  

NEW PLATFORM SUPPORT 

  

·       List the new operating system and virtualization platforms supported by SSR 2013 

R2?  

  

SUPPORT FOR 4K DISKS 

  

·       Which sector size combinations are supported by SSR 2013 R2?  

·       What operations are possible on disks with 4K logical sector size?  

·       What conditions apply to restore and copy-drive operations?  

·       Which virtual file formats are supported for P2V operations on 4Kn disks?  

  

SUPPORT FOR REFS INCREMENTAL 

  

·       What’s new in SSR 2013 R2 for REFS?  

  

SUPPORT FOR VHDX IN P2V OPERATIONS 

  

·       For which platforms is VHDX support available?  

·       What is the file size limit of the VHDX files?  

·       Which sector sizes are supported for VHDX?  

·       What type of conversion is possible for backup images with 4K sector size?  

·       What happens if a Recovery Point Set has both 512 and 4K sector size volumes?  

  

MEDIA ROTATION 

  

·       What is USB disk rotation?  

·       How do I enable USB disk rotation?  

·       What happens to the backup storage size quota when a USB disk is used for rotation?  

  



IMPROVED SUPPORT FOR RDX MEDIA ROTATION 

  

·       What is improved in RDX media rotation?  

  

GRANULAR LEVEL RECOVERY FOR EXCHANGE 2013 MAILBOX DATA 

  

·       Which additional Exchange versions does SSR 2013 R2 support for granular restore?  

·       Are Exchange databases which are hosted on disk with large sector sizes supported?  

·       Are there any changes made to the temp path?  

  

VMWARE ESXI 5.5 

  

·       What does SSR 2013 R2 support for VMware ESXi 5.5?  

·       Which version of VDDK is used by SSR 2013 R2 for physical to virtual conversions?  

·       The SSR installer creates a registry key to disable the verification of the SSL 

certificate. What is the location of this registry key?  

·       If there are issues with the P2V conversion, which registry key should be checked?  

  

SYMHELP 

  

·       Which SSR version is the Symantec Help tool integrated with? 

·       How is the SymHelp tool distributed in SSR 2013 R2? 

·       List the activities that can I performed due to the SymHelp integration in SSR 2013 

R2?  

·       Which utilities does the SymHelp tool replace in SSR 2013 R2? 

·       How do I select the tool to be used with Symantec System Recovery 2013 R2?  

·       In SSR 2013 R2, how do I invoke the Symantec help option?  

·       Which tasks can I performed due to the SymHelp integration in SSR 2013 R2?  

·       When SymHelp is launched in SSR 2013 R2, will it automatically update itself to the 

latest version?  

·       Can SymHelp be used in an SRD environment?  

·       Which utility should I used to collect logs in an SRD environment?  

·       Can SymHelp collect a system crash log?  

  

SUPPORT FOR WINDOWS 8.1 – UPDATE 1 AND WINDOWS SERVER 2012 R2 UPDATE 

  

·       Is ReFS support available on the 64-bit version of Windows 8.1?  

·       Which SRD creation method does Symantec recommend to be used on Windows 8.1 

update 1 and Windows 2012 R2 update?  

·       Does SSR-MS 2013 R2 support the backup and recovery client management of 

Windows 8.1 update 1 and Windows 2012 R2 update?  

  

SECURITY ENHANCEMENTS 

  

·         Is it necessary to encrypt backup jobs?  

·       In the Backup Wizard, why is the “Use password” option enabled by default?  



·       Can I set a password for backup without encrypting the backup data?  

·       What happens to the older backup jobs created using only password protection?  

·       Is the password information stored securely?  

  

PRODUCT BACKWARD COMPATIBILITY AND SUPPORT 

  

·       Can I restore data from recovery point created by a previous SSR version?  

·       How can I connect to Symantec System Recovery 2011 and Symantec System 

Recovery 2013 clients?  

·       Which client nodes can Symantec System Recovery 2013 R2 Management Solution 

manage?  

·       Can Symantec System Recovery 2013 R2 co-exist with other Symantec products?  

·       Which nodes can Symantec System Recovery Monitor 2013 R2 monitor?  

  

UPGRADE AND MIGRATION 

  

·       What are the supported Symantec System Recovery versions from which SSR users 

can upgrade to Symantec System Recovery 2013 R2? 

  

PLATFORM SUPPORT IN SSR LINUX 

  

·       Which new Linux operating systems does Symantec SSR 2013 R2 Linux Edition 

support?  

·       What happens if the server reboots?  

·       What is the minimum interval between successive scheduled backups?  

·       What is the maximum latency period for a job to trigger from scheduled time? 

·       Why does a 64-bit client computer need to have a 32-bit compatibility library present 

on the system?  

·       Why am I unable to locate the hard copy of Symantec System Recovery Linux 

Edition Quick Installation Guide?  

·       What are the common causes for installation failure?  

·       Where are the installation and upgrade failure logs located?  

·       Where are the SRD creation failure logs located?  

·       What are the contents of the /var/log/symsr/ directory?  

·       Which tool captures the system and product logs in case of unexpected failure or 

event?  

·       Where is the output of gatherLogs located?  

  

PRODUCT VIDEOS 

  

·       Where can I locate the Symantec System Recovery Disk creation videos?  

·       Why am I unable to view the Tech Center link in the Help menu > Help and Support?  

  

NOTEWORTHY TECHNOTES 

SSR Install/Upgrade related articles 

Backup related articles 



Restore related articles 

Virtualization related articles 

Symantec Management Platform (SMP) related articles 

Grandular Restore Option (GRO) related articles 

  

LICENSING 

  

Has the licensing methodology changed from the 

previous versions of SSR?-[To Top] 

The licensing methodology remains the same as the 

previous versions of SSR. 

  

Can SSR users upgrade to SSR 2013 R2 free of 

cost?-[To Top] 

SSR 2013 R2 is a paid release. SSR users with 

active maintenance contracts will get free upgrades 

as per the upgrade policy. SSR users that are not 

active on maintenance and are outside the grace 

period must purchase the version upgrade in order 

to receive the new version, for reinstating the 

maintenance. 

  

Will SSR 2013 R2 be available on FileConnect?-[To 

Top] 

SSR 2013 R2 will be available on FileConnect. 

SSR-MS will not be available on FileConnect. It 

will be available only via Symantec Installation 

Manager (SIM) listing (from Altiris Web site). For 

additional information about downloading and 

installing the Symantec System Recovery 

Management Solution, refer to TechNote: 

http://www.symantec.com/docs/TECH201523 

  

http://www.symantec.com/docs/TECH201523


Will SSR 2013 R2 be available via LiveUpdate?-[To 

Top] 

SSR 2013 R2 will not be available via LiveUpdate. 

  

  

SYSTEM RECOVERY DISK (SRD) 

  

Is WinPE still in use?-[To Top] 

WinPE is still in use. However, Symantec has discontinued the distribution of WinPE. This is 

because Microsoft has changed the licensing terms, which has affected the method of 

distributing WinPE bundled as a disk image. WinPE can still be obtained with the Microsoft 

Windows Automated Installation Kit (WAIK). The user must obtain WinPE from Typical-

WinRE or Advanced-ADK. 

  

Will SRD be available on FileConnect?-[To Top] 

SRD will not be available on FileConnect. The SSR FileConnect page will point to a TechNote 

with information about SRD and how SSR users can create it. For additional information, refer 

to TechNote: http://www.symantec.com/docs/TECH224997 

  

Will the SRD CD be shipped with SSR 2013 R2?-[To Top] 

The SRD CD will not be shipped with SSR 2013 R2. 

  

Where is the new SRD Creation utility located in the installer?-[To Top] 

The SRD Creation utility is located under TASK > Create New Recovery Disk within the user 

interface for supported OS(s) only. 

  

Is the SRD Creation utility installed by default with the package?-[To Top] 

http://www.symantec.com/docs/TECH224997


The SRD Creation utility is installed by default with the package on supported operating 

systems. 

  

How much space does the SRD Creation utility require?-[To Top] 

The SRD Creation utility requires 500 MB or more of disk space. 

  

Does the SRD Creation utility support the existing functionality?-[To Top] 

The SRD Creation utility supports existing functionality, such as customization of SRD and 

LOR. Customization features like Driver addition and Network options are also available with 

the new utility. 

  

State the operating systems on which SRD can be created?-[To Top] 

SRD can be created on the following operating systems: 

• Microsoft Windows 2008 and later – Server operating systems 

• Microsoft Windows 7 and later – Client operating systems 

On Microsoft Windows 2003, you cannot create an SRD like the other operating systems stated 

above. However, using an SRD created on the operating systems mentioned above, it is possible 

to customize this SRD (base SRD) on a Windows 2003 computer. Customization involves 

staging the base SRD and adding drivers found on the Windows 2003 computer (where it is 

being customized) and packaging it into a new SRD ISO. 

  

Is there a prompt to create an SRD after product installation?-[To Top] 

SSR users are prompted to create an SRD after the product installation. The intent is to remind 

SSR users to create an SRD at the earliest. 

  

Is there a prompt to create an SRD after product installation on an unsupported operating 

system?-[To Top] 

SSR users are prompted to create an SRD on a different system after the product is installed on 

an unsupported operating system, such as Microsoft Windows 2003/2003 R2, or Windows 



Vista. 

  

On which operating systems is SRD customization possible?-[To Top] 

SRD customization is possible on all the available operating systems supported by SSR 2013 

R2. 

  

What are the requirements for SRD creation?-[To Top] 

The user interface and the SRD Creation utility are required to create SRD. 

  

What are the new menu options available with SSR 2013 R2?-[To Top] 

Separate Task menu options are available for Create SRD, Customize SRD, Setup LOR, and 

Remove LOR. 

  

Are these options also available when connected to a remote client?-[To Top] 

None of these options are available when connected to a remote client. 

  

Is there a menu option available to check the SRD creation status?-[To Top] 

You can check the SRD creation status by clicking View > Show Recovery Disk Status. 

  

If LOR is already setup on the machine, will it be available in the menu options?-[To Top] 

If LOR is already setup on the machine, the user interface will not display the Task > Setup 

LOR option. It will display only the Task > Remove LOR option. 

  

When SSR 2013 R2 is launched, is there a prompt with information about the SRD creation 

status?-[To Top] 



When the user launches the SSR 2013 R2 console, a popup dialog box is displayed with 

information about the SRD creation status. 

  

What are the two different methods to create an SRD?-[To Top] 

The two different methods to create an SRD are Typical and Advanced. 

  

Where can SRDs be created?-[To Top] 

SRDs can be created on DVDs, USBs and ISOs. 

  

Can LOR be setup on a local system?-[To Top] 

LOR can be setup on a local system. 

  

Can both 32-bit and 64-bit SRDs be created?-[To Top] 

Both 32-bit and 64-bit SRDs can be created; two separate ISOs, DVDs, or USBs, one for each 

platform. 

  

What firmware can 64-bit SRD be booted on?-[To Top] 

64-bit SRD can be booted on BIOS and UEFI firmware. 

  

Which features need to be selected while installing Microsoft ADK?-[To Top] 

The following features need to be selected while installing Microsoft ADK: 

• Deployment tools 

 

• Windows Preinstallation Environment (Windows PE) 

  



List the key parameters that need to be considered before choosing between the Typical and 

Advanced option?-[To Top] 

The following table can be referred to while choosing between the Typical and Advanced 

options: 

  

Key Parameters Typical  Advanced (Using ADK 8.1) 

Recovery Disk Platform Same as OS Platform (32 bit 

or 64 bit) 

Both (32 bit and 64 bit) 

Windows Operating System 

that can be recovered 

Current OS and earlier 

versions 

All the OS(s) supported by 

SSR 2013 R2 

Languages Supported by 

recovery environment 

Current System Language One or more of 11 languages 

supported by SSR 2013 R2 

Disk space required on the 

local system 

~500 MB temporary space ~500 MB of temporary space 

per platform per language + 

3.5 to 5GB for ADK 

installation 

PowerShell and Cmdlets 

(Storage pool creation, iSCSI 

initiator and so on) support 

No Yes 

Time required for creation 

(approx.) 

10 Minutes 20 Minutes (+10 minutes for 

each language added) 

Can be customized on other 

OS 

Yes Yes 

What type of installation recommended on the latest operating systems supported by SSR 

2013 R2?-[To Top] 

SSR users should use the Typical installation option on the latest operating systems supported 



by SSR 2013 R2; Windows 8.1 Update 1 and Windows Server 2012 R2. 

  

What is the SRD creation based on when the Typical SRD creation option is used?-[To Top] 

Typical SRD creation is based on the WinRE environment of the existing operating system, 

which is the host system from where the utility is run. 

  

What is the SRD creation based on when the Advanced SRD creation option is used?-[To 

Top] 

Advanced SRD creation is based on the WinPE extracted from the ADK tool kit downloaded. 

This method provides the full, latest, and the most updated version of WinPE. 

  

What does the user need to download and install during SRD creation (Advanced)?-[To Top] 

The user needs to download and install Microsoft ADK. If ADK is not already installed, a 

download link is displayed on the wizard page. 

  

What features are available when the Typical option is used for Windows 8.1 update 1/ 

Windows Server 2012 R2 as host operating system?-[To Top] 

The features are listed in the table: 

Key Parameters Typical  Advanced (Using ADK 8.1) 

Recovery Disk Platform Same as OS Platform (32 bit 

or 64 bit) 

Both (32 bit and 64 bit) 

Recovers Win 8.1 

Update1/Windows 2012 R2 

Update and earlier 

Yes Yes 

Languages Supported by 

recovery environment 

Current System Language One or more of 11 languages 

supported by SSR 2013 R2 



Disk space required on the 

local system 

~500 MB temporary space ~500 MB of temporary space 

per platform per language + 

3.5 to 5GB for ADK 

installation 

PowerShell and Cmdlets 

(Storage pool creation, iSCSI 

initiator and so on) support 

No Yes 

Time required for creation 

(approx.) 

10 Minutes 20 Minutes (+10 minutes for 

each language added) 

Can be customized on other 

OS 

Yes Yes 

What happens when I do not have Windows 8.1 update or Windows Server 2012 R2 update 

and still want to use the Typical option?-[To Top] 

When SSR users do not have Windows 8.1 update or Windows Server 2012 R2 update SRD can 

still be created. 

 

• Recovery support will be limited to the Windows version installed on the host and earlier 

versions of Windows. 

 

• The SRD created on Microsoft Windows 8/Windows Server 2012 can be used to recover 

Windows 8/ Windows Server 2012 and earlier. It cannot be used to recover Windows 

8.1/Windows Server 2012 R2 and later. 

  

What is the Recoverability Matrix for the Typical option?-[To Top] 

The Recoverability Matrix for the Typical option is listed in the following table. 

Host OS OS To be Recovered   



Windows 

2003 

Windows 

Vista/ 

2008 SP2 

Windows 

7 / 2008 

R2 

Windows 

8 / 2012 

Windows 

8.1 / 2012 

R2 

Windows 

8.1 

Update 1 

/ 2012 R2 

update 

  

Windows 8.1 / 

2012 R2 / Update 

(Recommended) 

? ? ? ? ? ?   

Windows 8 / 

2012 
? ? ? ? × ×   

Windows 7 / 

2008 R2 
? ? ? × × ×   

Windows 2008 ? ? × × × ×   

What is the Recoverability Matrix for the Advanced option?-[To Top] 

The Recoverability Matrix for the Advanced option is listed in the following table. 

  Recoverability matrix for SRD created using Microsoft ADK 

  

Host OS 
Version of ADK 

used 

OS to be recovered 

  
Windows 

2003 

Windows 

Vista / 

2008 SP2 

Windows 

7 / 2008 

R2 

Windows 

8 / 2012 

Windows 

8.1 / 2012 

R2 

Windows 

8.1 Update 

1 / 2012 

R2 update 

  

Windows 

2008 SP2, 

Win 

7/2008 R2, 

Win 8 / 

2012, Win 

8.1 / 2012 

R2, Win 

8.1 Update 

1 / 2012 

ADK 8.1 

Update 

(Recommended)  

? ? ? ? ? ? 

  
ADK 8.0 (Not 

recommended) 
? ? ? ? × × 

http://www.microsoft.com/en-in/download/details.aspx?id=39982
http://www.microsoft.com/en-in/download/details.aspx?id=39982
http://www.microsoft.com/en-in/download/details.aspx?id=39982


R2 

Which method of SRD creation is faster?-[To Top] 

SRD creation is faster when the Typical option is used. SRD creation takes longer when the 

Advanced option is used. 

  

Why does the Typical option take lesser time?-[To Top] 

SRD creation is faster when the Typical option is used because WinRE already contains all the 

necessary packages. The process does not take more than 10 minutes. 

  

Why does the Advanced option take longer?-[To Top] 

SRD creation takes longer when the Advanced option is used for the following reasons: 

• ADK provides bare bones WinPE 

• Eight new packages added to the bare bones WinPE per language 

• All the packages are added for 32-bit and 64-bit separately 

  

Are progress bars and time updates available for the Advanced option?-[To Top] 

Progress bars and time updates are available at the macro level because the MSFT utility is used 

(dism.exe) for the Advanced option. 

  

What are the temporary/staging area considerations?-[To Top] 

The following are the temporary/staging area considerations: 

• SRD creation requires mounting of boot.wim/winre.wim on the boot volume (C:\). 

• Packages and utilities are added to the mounted wim. 

• The mounted wim file consumes at least 500 MB on C:\. 

• If more packages are added, more staging area is consumed on C:\. 

• Multi-lingual, dual platform SRD creation may consume up to 5 GB of temporary/staging area 

on C:\. 

  



What are the highlights for SRD with SSR 2013 R2?-[To Top] 

The highlights for SRD in SSR 2013 R2 are as follows: 

• WinRE.wim (Typical SRD) does not contain PowerShell packages and Storage cmdlets. 

• PowerShell and Storage cmdlets are optional packages available in ADK. 

• BitLocker support is available in both SRDs. 

• SRD created using the latest WinRE.wim/ADK can handle BitLocker drives of all the earlier 

operating systems. 

  

What are the Advanced language options for SRD creation?-[To Top] 

The Advanced language options for SRD creation are as follows: 

• The Language selection page allows the user to specify the languages to be included in the 

SRD. 

• If ADK 8.1 is installed, the user will be able to select any combination of languages. 

• If ADK 8.0 (required by 2003 based customization only) is installed, either one or more 

European languages or one of the Asian languages will be available for selection because all 

languages do not work together in the SRD environment. This is a Microsoft limitation. 

  

What are the SRD Target Media limitations?-[To Top] 

The SRD Target Media limitations are as follows: 

• 4K sector USB drives are not supported. 

• Both 32-bit and 64-bit SRD creation together support only ISO formats. 

• Both UEFI and BIOS firmware compatible 64-bit USB SRD support only FAT32 volume (not 

possible on NTFS). 

• Both 32-bit and 64-bit SRD on the same USB disk is not supported. 

• 32-bit SRD can boot on machines with firmware as BIOS only. 

• 64-bit SRD can boot on machines with firmware as UEFI or BIOS. 

  

What are the new options added to the driver mining page of the Customize SRD wizard?-[To 

Top] 

In SSR 2013 R2, all the installed Storage and Network drivers on host machine are displayed in 

the Customize SRD wizard, unlike the filtered Storage and Network drivers in the previous 

versions. This feature is added as there is no prior information of mined drivers with WinPE, 

and it is a time consuming process to filter the driver’s at runtime. The end result remains the 

same, only filtered drivers will be injected in the SRD. 

  



Is there any information about the driver mined displayed in the GUI?-[To Top] 

Operating system compatibility and other useful information about the driver mined are now 

displayed in the GUI. After adding a driver, You can view what operating systems it can be 

retargeted to during HIR. 

  

How is the locally mined driver list displayed when a 32-bit SRD is created on a 64-bit 

machine?-[To Top] 

When a 32-bit SRD is created on a 64-bit machine or the reverse, the mined driver list remains 

empty. 

  

Can a higher version driver be added to a lower version SRD?-[To Top] 

A higher version driver cannot be added to a lower version SRD. For example, a driver that is 

compatible only with Windows 8.1 cannot be added to Windows 8.0 SRD creation or 

customization. 

  

Why are drivers that are not compatible with WinPE added to the Driver database?-[To Top] 

Drivers that are not compatible with WinPE are added to the Driver database (DDB) only for 

use in Hardware Independent Restore (HIR). 

  

Does SSR 2013 R2 support pcAnywhere?-[To Top] 

SSR 2013 R2 does not support pcAnywhere. 

  

Does basic SRD creation require any licenses?-[To Top] 

The basic SRD creation feature does not require any SSR licenses. Customization features, such 

as driver injection and network settings in the wizard are licensed. The use of some features 

(referred to as customization features) that are available during SRD creation or customization 

require a valid SSR license. To create an SRD without using these features, no license is 

required. If the product is not licensed or the trial period has expired, these features are not 

available. A notification is displayed to the user before launching the SRD Creation wizard. 



  

When is the Typical option not available?-[To Top] 

The Typical option is not available when: 

• Operating system SKUs where WinRE is not available: For some operating systems the 

recovery environment is not available. Hence, the Typical option cannot be used for such 

operating system versions; these include Microsoft Windows Server 2003, Windows Server 

2003 R2, Windows Server 2008, and Windows Vista. For additional information about 

operating systems where the recovery environment is not available, refer to the following link: 

http://technet.microsoft.com/en-us/library/ff715587.aspx-[To Top] 

 

• WinRE is disabled using reagent.exe. 

  

Does Help in the SRD environment contain Hyperlinks?-[To Top] 

Help in the SRD environment does not contain Hyperlinks. 

  

Is the WebControl component available for SRD?-[To Top] 

The WebControl component is removed from SRD in SSR 2013 R2. 

  

When is the telemetry message displayed?-[To Top] 

A telemetry message is displayed during SRD creation, customization, and LOR setup. 

  

When is an error message generated?-[To Top] 

An error message is generated when SRD creation, customization, or LOR functionality fails. 

  

What information is captured to understand a customer's preferences?-[To Top] 

The following information is captured to understand customer preference: 

• Method of SRD creation 

http://technet.microsoft.com/en-us/library/ff715587.aspx


• Creation v/s customization v/s LOR feature usage 

• Media on which SRD is created 

  

Where are the SRD creation and customization logs located?-[To Top] 

The SRD creation and customization logs are located at: 

C:\ProgramData\Symantec\SYMANTEC SYSTEM RECOVERY\LOGS 

  

Name the log files related to SRD creation and customization?-[To Top] 

The log files related to SRD creation and customization are Srelog.dbg and SRDCreatorUI.txt. 

  

Which new utility is added to clean up mounted wims in case they are left un-mounted?-[To 

Top] 

WimCleaner.exe is the new utility added to clean up mounted wims in case they are left un-

mounted. 

  

What is the command to execute Wimcleaner.exe?-[To Top] 

The command to execute Wimcleaner.exe is: 

WimCleaner.exe [-cmdfile <file>] [-configfilepath <configfilepath>][-dismexepath 

<dismexepath>] [-help] [-locale <locale>] [-logfilepath<logfilepath>] [-resourceloc <resloc>] [-

temppath <temppath>][- wimmountpath <wimmountpath>] 

  

Where are the log files for Wimcleaner.exe located?-[To Top] 

The log files for Wimcleaner.exe are located at: 

C:\ProgramData\Symantec\Symantec System Recovery\Logs\WimCleanerLog.txt 

  

Name the features in SRD customization that are unchanged?-[To Top] 



Customization features, driver mining, external driver addition using driver INF, and Network 

options settings remain the same. 

  

What customization features are available during SRD creation?-[To Top] 

All the customization features are now available during SRD creation. 

  

What is the use of the SRD Customization feature?-[To Top] 

The use of the SRD Customization feature is now limited to driver mining from an existing 

Windows Server 2003 / 2003 R2 and Vista client - where SRD creation is not supported. 

  

Does SSR 2013 R2 provide the SRD customization feature for all operating systems?-[To Top] 

SSR 2013 R2 provides the SRD customization feature for all the operating systems. 

  

What are the limitations of Typical/Advanced SRD during customization?-[To Top] 

The following matrix displays the limitations of Typical/Advanced SRD during customization: 

SRD created 

on Host 

operating 

system 

TYPICAL OPTION - Can be customized on operating system 

Windows 

2003 

Windows 

Vista/ 

2008 SP2 

Windows 

7 / 2008 

R2 

Windows 

8 / 2012 

Windows 

8.1 / 2012 

R2 

Windows 

8.1 

Update 1 / 

2012 R2 

update 

               

Windows 7/ 

2008 R2 
× × ? × ? × 

               

Windows 8/ 

2012 
× × ? ? ? × 

               

Windows 8.1 / × × ? ? ? ? 
               



2012 R2 

   

SRD created 

on Host 

operating 

system 

ADVANCE OPTION - Can be customized on operating system 

Windows 

2003 

Windows 

Vista/ 

2008 SP2 

Windows 

7 / 2008 

R2 

Windows 

8 / 2012 

Windows 

8.1 / 2012 

R2 

Windows 

8.1 

Update 1 / 

2012 R2 

update 

               

ADK 8.1 

Update 
× ? ? ? ? ? 

               

ADK 8.0 ? ? ? ? ? × 
               

When can LightsOut Restore (LOR) be created?-[To Top] 

LOR can be setup while creating the base SRD or while customizing the existing SRD. 

  

Can I install only the LOR option?-[To Top] 

Yes, only the LOR option can be installed. 

  

What does LOR use on WinRE based operating systems (Windows 7 onwards)?-[To Top] 

LOR uses WinPE of WinRE on WinRE based operating systems. 

  

  

LIGHTSOUT RESTORE (LOR) PACKAGING 

  

Will the LOR package (SSR-MS) be available on 



the Global Product list?-[To Top] 

The LOR package (SSR-MS) will not be available 

on the Global Product list, due to Microsoft 

restrictions on the redistribution of WinPE. 

  

Will the SRD creation utility package be available 

as a part of SSR-MS 2013 R2 installation?-[To Top] 

Yes, the SRD creation utility (LORSetup.msi) 

package will be available as a part of SSR-MS 

2013 R2 installation. 

  

Will the LOR package be distributed with SSR-MS 

2013 R2?-[To Top] 

The LOR Package will not be distributed along 

with SSR-MS 2013 R2 due to Microsoft 

restrictions on the redistribution of WinPE. 

  

Do I need to create the LOR Package using the SRD 

Creation utility?-[To Top] 

Yes, SSR users explicitly need to create the LOR 

package using the SRD Creation utility. 

  

What is the new entry in the Getting Started 

Webpart for LOR?-[To Top] 

The new entry added to the Getting Started 

Webpart is Create Symantec System Recovery 

Disk (ISO) and generate LightsOut Restore 

Package. 

  

List the steps displayed in the Creating the 

Symantec Recovery Disk (ISO) and generating 



LightsOut Restore link?-[To Top] 

The Creating the Symantec Recovery Disk (ISO) 

and generating LightsOut Restore link opens the 

Creating the Symantec Recovery Disk (ISO) and 

generating LightsOut Restore package page, 

which displays the following steps: 

 

1. Navigate to Settings > Backup and Recovery > 

LightsOut Restore Packages > 2013 R2 > Create 

Symantec System Recovery Disk (ISO) and 

generate LightsOut Restore packages. 

2. A link (click here) is provided to download and 

install the SRD Creation utility. 

3. Using the utility, create 32-bit and 64-bit 

Symantec Recovery Disk (ISOs). 

4. Upload this Symantec Recovery Disk (ISOs) to 

the SSR-MS server, and generate the LightsOut 

Restore package. 

  

Where is a copy of the SRD (ISOs) available?-[To 

Top] 

A copy of Symantec Recovery Disk (ISOs) is 

available at the server package location. 

  

State the option in the GUI to generate the LOR 

Package?-[To Top] 

The option in the GUI which is used to generate 

LOR package is Create Symantec System 

Recovery Disk (ISO) and generate LightsOut 

Retore Package. 

 

1. Navigate to Home > Getting Started. 

2. Scroll down to and then click on option 5. 

3. Follow the instructions that now appears on the 

screen to generate a LOR package.  



  

  

How do I upload 32-bit and 64-bitRecovery Disk 

(ISOs) when Generating LightsOut Restore 

Package?-[To Top] 

 

1. Navigate to Settings > Backup and Recovery > 

LightsOut Restore Packages > 2013 R2 > Create 

Symantec System Recovery Disk (ISO) and 

generate LightsOut Restore packages. 

2. Check the option, 'Select the Symantec System 

Recovery Disk (ISOs) to generate the LightstOut 

Restore package on then server. 

3. Click the Browse button and naviagate to either 

the 32-bit or 64-bit SRD *.ISO file. 

4. Click the Generate LightsOut Restore 

Package button. 

Is there a new page available in the Package and 

Policies tab for LOR?-[To Top] 

Yes, there is a new page available in the Package 

and Policies tab for LOR. 

  

SYMANTEC MANAGEMENT PLATFORM (SMP) 7.5 PLATFORM SUPPORT 

  

What is the SMP (Symantec Management Platform) 7.5 supportability matrix in SSR 2013 

R2?-[To Top] 

The following table displays the SMP 7.5 supportability Matrix in SSR 2013 R2. 

Symantec Management 

Platform 
Operating system   



7.5 
Windows 2008 R2 

Enterprise/Standard Edition 
Supported 

7.5 SP1 Windows 2012 R2 Not Supported 

Will SSR-MS 2013 R2 be listed in SIM?-[To Top] 

SSR-MS 2013 R2 is listed as a compatible product of Symantec Management Platform 7.5 in 

SIM. 

  

Which SMP version has reached End of Life with SSR 2013 R2?-[To Top] 

SMP 7.0 (32-bit) and SMP 7.1 (64-bit) has reached End of Life with SSR 2013 R2. 

  

Is the SSRMS_x 32 build available with SSR 2013 R2?-[To Top] 

As SMP 7.0 has reached EOL, the SSRMS_x 32 build is not available with SSR 2013 R2. 

  

Which older versions can be upgraded to SSR-MS 2013 R2?-[To Top] 

Only SSR-MS 2011 and SSR-MS 2013 can be upgraded to SSR-MS 2013 R2. 

  

Can a SSR user running SSR-MS 2013 R2 manage a client running BESR 2010?-[To Top] 

A user running SSR-MS 2013 R2 cannot manage a client running BESR 2010. 

  

Where are the SMP Server logs located?-[To Top] 

The SMP Server logs are located at: 

C:\ProgramData\Symantec\SMP\Logs 



  

Where are the SMP Agent logs located?-[To Top] 

The SMP Agent logs are located at: 

C:\ProgramData\Symantec\Symantec Agent\Logs 

  

  

NEW PLATFORM SUPPORT 

  

List the new operating system and virtualization 

platforms supported by SSR 2013 R2?-[To Top] 

SSR 2013 R2 now supports Windows 8.1 Update 

and Windows 2012 R2 Update operating systems. 

It also supports the following virtualization 

platforms: 

• XenServer 6.2 SP1 (Guest VMs are supported) 

• VMWare ESXi 5.5 Update 1a (P2V supported) 

  

  

SUPPORT FOR 4K DISKS 

  

Which sector size combinations are supported by SSR 2013 R2?-[To Top] 

The sector size combinations that are supported by SSR 2013 R2 for Windows 8 and Windows 

Server 2012, 4Kn disks are listed in the table. 

Logical Sector size Physical sector size Short-name 



512 512 512n(512 native) 

512 4096 N512e (512 emulated) 

4096 4096 4Kn (4K native) 

What operations are possible on disks with 4K logical sector size?-[To Top] 

Using SSR 2013 R2, you can perform the following operations on disks with 4K logical sector 

size: backup, restore, P2V (physical to virtual) conversion, and copy-drive operations. 

  

What conditions apply to restore and copy-drive operations?-[To Top] 

For restore and copy-drive operations, the sector size of source volume and destination volume 

must be the same. You can restore backups of volumes with 4K sector size only on a 4K sector 

disk. Similarly, for backups of volumes with 512 byte sector size, the restore can only be 

performed on a 512 byte sector disk. 

  

Which virtual file formats are supported for P2V operations on 4Kn disks?-[To Top] 

For P2V conversion of volumes on 4Kn disks, only the “VHDX” virtual file format is 

supported. This is because VHDX is the only format which supports 4K sector size. The sector 

sizes of the source and destination volumes/disks are displayed in respective GUI screens of 

restore, P2V, and copy-drive operations. 

  

  

  

  

SUPPORT FOR REFS INCREMENTAL 

  



What’s new in SSR 2013 R2 for REFS?-[To Top] 

The Resilient File System (ReFS) was introduced 

in Windows Server 2012 and is also now available 

with Windows 8.1 (64-bit). SSR 2013 R2 supports 

incremental backups of ReFS volumes. All the 

other related features such as recovery point set 

management and smart reconcile function are the 

same as in NTFS volumes. 

  

  

SUPPORT FOR VHDX IN P2V OPERATIONS 

  

For which platforms is VHDX support available?-

[To Top] 

VHDX support is available only on Microsoft 

Windows 8 and Microsoft Windows Server 2012 

and later. In addition, backup images can be 

converted into virtual disks for Generation2 virtual 

machines. 

  

What is the file size limit of the VHDX files?-[To 

Top] 

The VHDX file size limit is 64 TB. The VHD has a 

size limit of 2 TB. 

  

Which sector sizes are supported for VHDX?-[To 

Top] 

VHDX supports disk with 512 and 4K sector sizes. 

  

What type of conversion is possible for backup 



images with 4K sector size?-[To Top] 

Backup images with 4K sector size can be 

converted only to Hyper-V VHDX. 

  

What happens if a Recovery Point Set has both 512 

and 4K sector size volumes?-[To Top] 

If a Recovery Point Set has both 512 and 4K sector 

size volumes, it can only be converted to VHDX. 

In this case, different virtual disks are created for 

4K and 512 sector size volumes. 

  

  

MEDIA ROTATION 

  

What is USB disk rotation?-[To Top] 

SSR 2013 R2 allows SSR users to use USB drives 

as backup destination on a rotational basis. This is 

possible by making the aliasing feature optional. 

SSR users can choose not to alias USB disk to be 

used as the backup destination, which enables SSR 

users to use any USB disk for a given backup job. 

  

How do I enable USB disk rotation?-[To Top] 

To enable USB disk rotation, the user has to mount 

a USB disk to the same mount point, which was 

present at the time the backup job was created. For 

example, “d:\Symantec_Backups” 

  

What happens to the backup storage size quota 

when a USB disk is used for rotation?-[To Top] 



The backup storage size quota is disabled in the 

managed backup destination settings, for USB 

disks involved in USB rotation. SSR users should 

use the recovery point set limit option in the job as 

an alternative. SSR notifies the user as soon as 

backup job starts, if there is insufficient space 

available on the USB to complete the backup. 

  

  

IMPROVED SUPPORT FOR RDX MEDIA ROTATION 

  

What is improved in RDX media rotation?-[To Top] 

SSR 2013 R2 has enhanced its support for 

automatically cleaning-up of images on RDX 

media. Earlier, when the recovery point limit was 

passed, SSR deleted the oldest recovery point from 

the backup location and history file, though the 

recovery point was unavailable on a particular 

media. Thus, the image was orphaned on the 

media. SSR now tags such images, as “Mark for 

deletion” in the history file. When the cartridge that 

has the image becomes available for backup, SSR 

first cleans-up or deletes this image and then 

proceeds with the backup job. 

Also when a recovery point is spanned across 

multiple cartridges, SSR cleans-up the spanned 

image. However, the entry in the history file is not 

removed until all the spanned the images are 

deleted. Thus, there will not be any orphan images 

left on the cartridge. 

  

  

GRANULAR LEVEL RECOVERY FOR EXCHANGE 2013 MAILBOX DATA 

  



Which additional Exchange versions does SSR 2013 

R2 support for granular restore?-[To Top] 

SSR 2013 R2 supports backup and granular restore 

of Microsoft Exchange 2013 using Outlook 2007 

and Outlook 2010. Note that support for Outlook 

2013 is limited. 

  

Are Exchange databases which are hosted on disk 

with large sector sizes supported?-[To Top] 

Exchange databases hosted on disk with large 

sector sizes, for example, 512e (512 as logical 

sector size and 4K as physical sector size) and 4Kn 

(logical and physical sector size is 4K) are 

supported. Exchange databases hosted with a 

combination of file system (NTFS or REFS) and 

disk sector sizes (512e, 512n, and 4Kn) are also 

supported. 

  

Are there any changes made to the temp path?-[To 

Top] 

Hosting or creating a temp path for restore 

operations is changed to the path where the 

database is mounted. It’s called “StagingArea”. 

  

  

VMWARE ESXI 5.5 

  

What does SSR 2013 R2 support for VMware ESXi 

5.5?-[To Top] 

SSR 2013 R2 supports physical to virtual 

conversion for VMware ESXi 5.5. SSR 2013 R2 

also supports VMs running on ESX 5.5. 



  

Which version of VDDK is used by SSR 2013 R2 for 

physical to virtual conversions?-[To Top] 

SSR 2013 R2 uses VMware VDDK 5.1.3 for 

physical to virtual conversions. 

   

If there are issues with the P2V conversion, which 

registry key should be checked?-[To Top] 

In case of problems with P2V conversions, the 

registry key 

HKLM\SOFTWARE\Wow6432Node\VMware, 

Inc.\VMware Virtual Disk Development Kit must 

be checked and the value must be confirmed to be 

VerifySSLCertificates= dword: 00000000. 

  

SYMHELP 

Which utilities does the SymHelp tool replace in 

SSR 2013 R2?-[To Top] 

SupportGather and SeaST.exe are the two utilities 

that SymHelp replaces in SSR 2013 R2. 

  

How do I select the tool to be used with Symantec 

System Recovery 2013 R2?-[To Top] 

Select SSR as the product by following the steps 

below. Refer to the Symantec System Recovery 

2013 R2 User's Guide for more information. 

1. Within the user interface go to Help > Symantec 

Help Support. 

2. Click one of the available scans on the left; Refer 

to the Symantec System Recovery 2013 R2 User's 

Guide for more information. 

3. In the popup window that appears under 

Installed products select System Recovery. 

4. Click Scan. 



  

Which SSR version is the Symantec Help tool 

integrated with?-[To Top] 

The Symantec Help tool is integrated with 

Symantec System Recovery 2013 R2. 

  

In SSR 2013 R2, how do I invoke the Symantec help 

option?-[To Top] 

The Symantec Help option can be invoked from 

Help > Symantec Help Support. 

  

How is the SymHelp tool distributed in SSR 2013 

R2?-[To Top] 

The SymHelp tool is distributed as part of the 

utility tool in the SSR 2013 R2 installation 

package. 

  

List the ACTIVITIES can I performed due to the 

SymHelp integration in SSR 2013 R2?-[To Top] 

Due to the SymHelp integration with SSR 2013 R2, 

the following activities can be performed: 

• Generating reports about the installed product 

health 

• Checking for product install requirements 

• Collecting data like logs, files and so on for 

support cases 

  

Which TASKS can I performed due to the SymHelp 

integration in SSR 2013 R2?-[To Top] 

You can perform the following tasks due to the 

SymHelp integration with SSR 2013 R2: 

• Search for articles in the SSR 2013 knowledge 



base 

• Open or manage support cases 

• Collect extra information along with what 

Symantec Help has found while scanning 

  

When SymHelp is launched in SSR 2013 R2, will it 

automatically update itself to the latest version?-[To 

Top] 

The SymHelp tool is a self-extracting and self-

upgradable tool. Each time you launch the tool, it is 

updated to the latest version. 

  

Can SymHelp be used in an SRD environment?-[To 

Top] 

SymHelp is not supported in an SRD environment. 

  

Which utility should I used to collect logs in an SRD 

environment?-[To Top] 

To collect log files in the SRD recovery 

environment use the SupportGather.exe. Contact 

technical SymantecTechnical Support for further 

assistance.  

  

Can SymHelp collect a system crash log?-[To Top] 

SymHelp cannot collect a system crash log. 

  

  

SUPPORT FOR WINDOWS 8.1 – UPDATE 1 AND WINDOWS SERVER 2012 R2 UPDATE 

  



Is ReFS support available on the 64-bit version of 

Windows 8.1?-[To Top] 

The Resilient File system is now supported on the 

64-bit version of the Windows 8.1 operating 

system. 

  

Which SRD creation method does Symantec 

recommend to be used on Windows 8.1 update 1 

and Windows 2012 R2 update?-[To Top] 

Symantec recommends to select the “Typical” SRD 

creation method on the latest supported operating 

systems. 

  

Does SSR-MS 2013 R2 support the backup and 

recovery client management of Windows 8.1 update 

1 and Windows 2012 R2 update?-[To Top] 

SSR-MS 2013 R2 supports the backup and 

recovery client management of Windows 8.1 

update 1 and Windows 2012 R2 update. 

  

  

SECURITY ENHANCEMENTS 

  

ACL is set on which registry key and install directory?-[To Top] 

ACL is set on: 

  

HKEY_LOCAL_MACHINE\SOFTWARE\Symantec\Symantec 

System Recovery 

C:\Program Files\Symantec\Symantec System Recovery\ 

This key and folder, is used by SSR to store application and install 



level settings. Irrespective of previous permissions, the permissions 

are reset to: 

• Full permissions to Administrators, CreatorOwner, System, 

TrustedInstaller groups 

• Read and Execute permissions to SSR users group 

  

Is it necessary to encrypt backup jobs?-[To Top] 

While it is not necessary to encrypt backup jobs, it is recommended 

that backups should be encrypted using AES encryption. 

  

In the Backup Wizard, why is the “Use password” option enabled 

by default?-[To Top] 

It is a recommended security practice to protect the backup data 

using a password. 

  

Can I set a password for backup without encrypting the backup 

data?-[To Top] 

The option to set a password for backup without encrypting the 

backup data is no longer available. When the “Use password” 

option is selected, AES encryption must be defined. 

  

What happens to the older backup jobs created using only 

password protection?-[To Top] 

Older backup jobs using only password protection (without AES 

encryption) would continue to run as is. However, when such a job 

is modified, the AES encryption must be set. 

  

Is the password information stored securely?-[To Top] 

Yes, the password information is now stored securely in the 

memory using Microsoft Data Protection APIs. 



  

PRODUCT BACKWARD COMPATIBILITY AND SUPPORT 

  

Can I restore data from recovery point created by a 

previous SSR version?-[To Top] 

Yes, Symantec System Recovery 2013 R2 supports 

restoring systems and data from the recovery points 

created by Symantec System Recovery 2011 and 

Symantec System Recovery 2013. 

  

How can I connect to Symantec System Recovery 

2011 and Symantec System Recovery 2013 clients?-

[To Top] 

Symantec System Recovery 2013 R2 can remote 

connect to Symantec System Recovery 2011 and 

Symantec System Recovery 2013 clients only 

using SSR’s 1-to-1 Management Solution. 

  

Which client nodes can Symantec System Recovery 

2013 R2 Management Solution manage?-[To Top] 

Symantec System Recovery 2013 R2 Management 

Solution can manage only Symantec System 

Recovery 2011 and Symantec System Recovery 

2013 client nodes. 

  

Can Symantec System Recovery 2013 R2 co-exist 

with other Symantec products?-[To Top] 

Yes, SSR 2013 R2 can co-exist with Symantec 

Norton 360, Symantec Endpoint Protection, and 

Symantec Backup Exec 2014. SSR 2013 R2 

compatibility is limited to Symantec products that 

are currently in use or have not reached End of Life 

(EOL). Any exceptions or limitations for any 



Symantec product are as follows: 

• Symantec Endpoint Encryption has limited 

support. For additional information, refer to 

TechNote: 

http://www.symantec.com/docs/TECH74467 

• The minimum SEP versions supported are 12.1-

RU4-MP1a and later. 

• SSR cannot create a backup when (at the same 

time) Continuous Protection Server (CPS) is 

running. 

• All the existing Backup Exec versions continue to 

be supported by SSR 2013 R2. 

• Compatibility (as co-existing products) has not 

been tested for DLO and NBU. 

  

Which nodes can Symantec System Recovery 

Monitor 2013 R2 monitor?-[To Top] 

Symantec System Recovery Monitor 2013 R2 can 

monitor nodes protected by Symantec System 

Recovery 2011 and Symantec System Recovery 

2013. 

  

  

UPGRADE AND MIGRATION 

  

What are the supported Symantec System Recovery 

versions from which I can upgrade to Symantec 

System Recovery 2013 R2?-[To Top] 

The SSR users can upgrade to Symantec System 

Recovery 2013 R2 from: 

• Symantec System Recovery 2011 

• Symantec System Recovery 2013 

  

  

http://www.symantec.com/docs/TECH74467


PLATFORM SUPPORT IN SSR LINUX 

  

Which new Linux operating systems does Symantec SSR 2013 R2 Linux 

Edition support?-[To Top] 

The Symantec System Recovery 2013 R2 Linux Edition supports: 

• Red Hat Enterprise Linux 6.5 

• Community ENTerprise operating system 5.10 

• Community ENTerprise operating system 6.5 

  

What happens if the server reboots?-[To Top] 

On server reboot, a new recovery point set is initiated with base backup. 

  

What is the minimum interval between successive scheduled backups?-

[To Top] 

The minimum interval between successive scheduled backups is one 

hour. 

  

What is the maximum latency period for a job to trigger from scheduled 

time?-[To Top] 

The maximum latency period for a job to trigger from scheduled time is 

14 minutes. 

  

Why does a 64-bit client computer need to have a 32-bit compatibility 

library present on the system?-[To Top] 

The Symantec System Recovery Linux Management Solution deploys 

32-bit Symantec System Recovery Linux Edition on 64-bit Linux 

platform for management. Clients must have a 32-bit compatibility 

library present on the system. 

  



I am unable  to locate the hard copy of Symantec System Recovery 

Linux Edition Quick Installation Guide?-[To Top] 

The printing of Symantec System Recovery Linux Edition Quick 

Installation Guide has been discontinued. 

  

What are the common causes for installation failure?-[To Top] 

Some of the causes for installation failure are: 

• Minimum space us not available 

• Required packages are missing 

  

Where are the installation and upgrade failure logs located?-[To Top] 

The installation and upgrade logs are located at: 

/var/log/symsr/InstallUninstall.log 

  

Where are the SRD creation failure logs located?-[To Top] 

The SRD creation logs are located at: /var/log/symsr/createSRD***.log 

  

What are the contents of the /var/log/symsr/ directory?-[To Top] 

The contents of the /var/log/symsr/ directory are: 

• Debug 

• Application 

• InstallUnistall.log 

• Alerts 

• History 

  

Which tool captures the system and product logs in case of unexpected 

failure or event?-[To Top] 

The gatherLogs tool captures the system and product logs in case of 

unexpected failure or event. The command used is #gatherLogs. It is 



installed along with Symantec System Recovery Linux Edition. 

  

Where is the output of gatherLogs located?-[To Top] 

The output of the gatherLogs is located at: 

#/tmp/Symantec_System_Recovery_for_Linux_logs.<timestamp>.zip 

  

  

PRODUCT VIDEOS 

  

Where can I locate the Symantec System Recovery 

Disk creation videos?-[To Top] 

The Symantec System Recovery Disk creation 

videos are a step-by-step guide on how to create a 

Symantec System Recovery Disk. THe videos can 

be found on Symantec TV and in the article 

TECH225888 - How to create a Symantec System 

Recovery 2013 R2 (SSR 2013R2) System Restore 

Disk (SRD) 

  

Why am I unable to view the Tech Center link in 

the Help menu > Help and Support?-[To Top] 

The Tech Center link in the Help menu > Help 

and Support is replaced with a Product Videos link. 

This link directs you to SymantecTV where the 

Symantec System Recovery product videos are 

available. 

  

NOTEWORTHY TECHNOTES 

-[To Top] 

  

http://www.symantec.com/tv/
http://www.symantec.com/docs/TECH225888


   

SSR Install/Upgrade related articles 

  

TECH225024 - Symantec System Recovery 2013 R2 

installation fails with the 2147023293 

error code. 

TECH225000 - When you try to install Symantec 

System Recovery 2013 R2 from 

browser.exe, the media is corrupt error 

message is displayed. 

TECH225019 - Symantec System Recovery 2013 R2 

upgrade from Beta to RC build fails on 

Windows 2003. 

TECH225017 - If you install Symantec System 

Recovery 2013 R2 and then install 

Backup Exec 2014 on the same 

computer, the Exchange Mail restore in 

Granular Restore Option fails. 

TECH224990 - After you upgrade to Symantec System 

Recovery 2013 R2, launch the 

Symantec System Recovery console, the 

console exits immediately. 

TECH224912 - A non-default administrator fails to 

extract Symhelp.exe in the default 

folder using a Windows 8.1 computer. 

TECH72138 - Symantec System Recovery console 

fails to initialize with an error during 

startup. 

TECH224997 - Symantec System Recovery disk is not 

available on FileConnect. 

 

  

Backup related articles 
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TECH224910 - Corrupt system volume image is 

created over the CIFS network. 

TECH224935 - Backup job appears to be stalled for a 

recovery point set job scheduled to 

backup volume present on a USB disk 

after every reboot. 

TECH224976 - The offsite to FTP destination task 

fails on any operating system with 

Russian locale. 

TECH225023 - The VDS window becomes 

unresponsive when Symantec System 

Recovery 2013 R2 performs the Copy 

My Hard Drive operation. 

TECH225022 - Symantec System Recovery is unable 

to see volumes on EFI systems if a disk 

is encrypted with PGP. 

TECH225021 - Symantec System Recovery 2013 R2 

does not support dynamic volumes on 

4K native disks. 

 

  

Restore related articles 

  

TECH224921 - A restored Windows 2003 computer 

fails to boot with the error: Windows 

could not start because following file is 

missing or corrupt 

"System32\drivers\pciide.sys". 

TECH225026 - Issues observed during auto recovery 

from Symantec System Recovery Disk 

when restoring to volumes created on a 

storage pool or backup images stored on 

such volumes. 

TECH225025 - For HP-DL-380P Server, Windows 

2008 R2/Windows 7 fails to boot after 

performing a bare metal restore from 

http://www.symantec.com/docs/TECH224910
http://www.symantec.com/docs/TECH224935
http://www.symantec.com/docs/TECH224976
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http://www.symantec.com/docs/TECH225025


Symantec Recovery Environment. 

TECH224932 - An error is displayed after restoring the 

incremental backup of ReFS volume 

created post Windows 2012 R2 to 

Windows 2012 R2 Update. 

TECH224814 - Stale entry of drive letters is displayed 

in the Symantec System Recovery 

console after you restore the UEFI 

system backups on a different computer. 

 

  

Virtualization related articles 

  

DOC7714 - Symantec System Recovery 2013 R2: 

Hyper-V Replica and Extended Replica 

Environments 

TECH225018 - An error message is displayed when 

you try to connect to ESXi 5.5 and 

above for P2V conversion on Windows 

2003. 

TECH225002 - P2V conversion fails with a Recovery 

Point Access Method error. 

TECH224978 - Unable to boot into the Windows 

recovery Environment after physical to 

virtual conversion or system restore. 

 

  

Symantec Management Platform (SMP) related articles 

  

TECH224988 - An incorrect error message is 

displayed, if you launch the Symantec 

System Recovery 2013 R2 Management 

Solution console from a remote 

computer when the server is restarted or 

http://www.symantec.com/docs/TECH224932
http://www.symantec.com/docs/TECH224814
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http://www.symantec.com/docs/TECH225018
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down. 

   

TECH224981 - The Symantec Management Agent 

(SMA) crashes if you upgrade the agent 

with Symantec Management Platform 

(SMP) 7.1 having Symantec System 

Recovery plugin 10.0.x on a 64-bit 

managed Win computer to SMP 7.5. 

TECH224915 - If you do not upgrade Symantec 

Management Agent from 7.0 or 7.1 to 

7.5, the Symantec System Recovery 

plugin version displays 11.1.XXXXX 

instead of 11.1.0.XXXXX in the 

Symantec System Recovery 2013 R2 

Management Solution. 

TECH224934 - Symantec Management Agent for 

Linux (formerly known as Altiris agent) 

crashes after deploying the Symantec 

System Recovery Linux plugins from 

Symantec System Recovery 2013 R2 

Linux Management Solution. 

TECH224933 - Symantec System Recovery 2013 R2 

Management Solution supports 

installation of the LightsOut Restore 

package creation utility in Windows 

Vista. 

TECH224936 - The Convert to Virtual by Destination 

task fails for Symantec System 

Recovery 2011 clients installed on a 64 

bit computer and managed by Symantec 

System Recovery 2013 R2 Management 

Solution. 

TECH225020 - When you generate a LightsOut 

Restore package, an incorrect error 

message is displayed if there is 

insufficient space on the system drive. 
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Grandular Restore Option (GRO) related articles 

  

TECH224931 - Granular Restore Option fails to 

prepare SharePoint metadata 

information files. 

TECH224911 - Limited support for Outlook 2013 in 

Symantec System Recovery 2013 R2. 

TECH224815 - Outlook messages/mails displays 

HTML tags if you have Outlook 2013 

installed on your computer. 

TECH224989 - Recovery Point Browser displays the 

error: Browsing recovery points of 

Resilient File System (ReFS) volumes 

is not supported. 
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